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Building Information Modeling, or BIM, authoring software, such as Vectorworks®, allows 
architects and other professionals within the AEC industry to create complex, data-rich 3D 
models for the purpose of exploring and documenting a design. This continually growing 
technology also allows for new ways of sharing information among all consultants on a 
project. As a result, it is essential to establish an agreed-upon method and file format for 
information exchange between the different disciplines on a team who are each utilizing different 
software. In some cases, a traditional 2D line drawing exchange, such as a PDF or DWG, is 
needed to support those who have not entered the 3D realm. Other times, exchange of only 
geometry in the form of a 3D DWG may be needed for clash detection and as a background 
for referencing. However, if the file exchange needs to support Building Information Models 
and the sharing of geometry and data, then the IFC file format should be considered.

WHAT IS IFC? 

IFC, or Industry Foundation Classes, is a standardized open-source file format that is optimized for 
building information modeling. Much like PDF or HTML, the specification for the code to write this 
file format is freely available to the public for use and to developers for the creation of their own 
tools to handle the data format. 

This means that all software vendors have equal access to the specifications and can create the 
necessary import and export technology. No single vendor controls this format or makes money 
from licensing this technology. IFC is an international open standard, developed and maintained by 
buildingSMART International.

The most important thing to remember is that IFC encodes both geometry and data. The inclusion 
of both geometry and data is what makes IFC ideal for an open BIM exchange. The IFC file format 
includes:

GEOMETRY
IFC geometry is robust and includes vectors, solids, surfaces, etc.  

DATA
IFC supports three main aspects of the data in a BIM model:

Semantics

the meaning or identity of a collection of geometry related to 
building objects, such as a window within a wall.

Relationships

speaks to how the geometry is related to each other, such as a door inserted into a wall.

Properties

definition of materials that includes data, such as cost or model number.

INTRODUCTION AND OVERVIEW
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Central to the concept of IFC is the idea of semantic objects. When the geometry of 
a model is identified as a building element and has meaning or a definition within 
the context of construction, it becomes a semantic object for a digital model.

IFC permits building models and data to be shared and maintained 
throughout all stages of the lifecycle of a construction project: design, 
analysis, specification, fabrication, construction, and occupancy.  

The capabilities and usage for IFC are evolving. Some examples of the use of IFC include:

 ∙ Collaborative design, where, for example, an architect exports an architectural 
model to a structural engineer for analysis and design, and then imports 
the structural model in an IFC format, for coordination purposes. 

 ∙ Energy performance simulation and analysis of a building envelope and systems.
 ∙ Automated analysis of code compliance.
 ∙ Space planning and space inventory analysis.

WHY IS IFC IMPORTANT?

Being an open-source file format, IFC supports a more collaborative BIM process, allowing 
each project stakeholder to make meaningful contributions to the project using the best-
suited tool for the job. Every member of the project team has different needs and different 
end-goals, meaning that each of them uses the BIM model for different purposes and to 
gather or generate different data. There is no single application that can fulfill all these 
different uses and needs. If each project member is able to use the tool of their choice, then 
they are able to do their part in an efficient, effective, and executable manner, all the while 
creating a model that can be shared and effectively used throughout the BIM process. 

Some other benefits of using the IFC file format include: ownership of your project 
contribution and the ability to be independent of limitations of versioning found 
in proprietary file formats, portability and accessibility of project information 
from different applications, and the extensibility of an IFC file. 

WHAT DOES IFC MEAN FOR VECTORWORKS USERS?

For Vectorworks users, IFC is the file format needed in order to share both the geometry and 
data of BIM models with other project team members, such as the project owner, the project 
consultants, the construction manager, or others who may not be using Vectorworks. 

Vectorworks supports BIM interoperability using the IFC file format. Vectorworks Architect 
currently supports IFC versions 2x2, 2x3, and 4. Vectorworks Architect has been certified by 
buildingSMART International for the export of models based on the IFC2x3 Coordination View 2.0 – 
Architecture model view definition, as well as the import of any IFC2x3 Coordination View 2.0 model. 

INTRODUCTION AND OVERVIEW [CONT’D]
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USING IFC IN VECTORWORKS

Vectorworks Architect provides you with the necessary tools to create a 
complete and useful IFC model. Nearly all default content within Vectorworks 
Architect is tagged for IFC export, requiring minimum user effort. 

With the IFC Data command, you can assign IFC object tags and properties to custom-
built geometry so applications that read IFC files can identify these objects.

Additionally, when IFC files are imported into Vectorworks, the IFC objects within the file 
are brought in as a particular and flexible kind of plug-in object called an IFC Entity. An 
IFC Entity, as opposed to a Vectorworks object, is created because the properties of objects 
created in other programs cannot easily be matched to all the corresponding Vectorworks 
object properties and controlling parameters. For more detailed information on the export 
and import of IFC files, see the Exporting and Importing sections of this guide. 

The semantic definition of an IFC Entity, such as an IfcColumn, IfcWall, or IfcWindow, 
is maintained and displayed. Like a group or symbol, an IFC Entity can contain a 
collection of geometry, and, like a plug-in object, it can be inserted into walls and 
has sets of data and properties attached to it. With this generalized import capability, 
Vectorworks can import any kind of object supported by the IFC standard.

Space objects are somewhat unique in that when an IFC file containing space objects 
that were created in another program is imported into Vectorworks, the IfcSpace 
objects are correctly translated into corresponding Vectorworks Space objects. 

IFC OBJECTS AND PROPERTY SETS IN VECTORWORKS

An IFC object is a building object that has been defined by both its occurrence and 
type. This means that a building object created in Vectorworks, either with the 
default tools or a user-created object, can be tagged as an IFC object to define 
its semantics, properties, and relationships to other building objects. 

When an object is tagged for IFC, it is assigned an IFC Property Definition known as a property 
set (pSet). An IFC Property Definition captures an object’s property set, or associative data. 
This set of properties is attached to the object. More than one property set can be associated 
with an IFC object, including custom property sets that are defined by the Vectorworks user.
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USING IFC IN VECTORWORKS [CONT’D]

IFC OBJECT TAGS FOR STANDARD OBJECTS 

Most objects supplied with Vectorworks Architect, through the default building tools 
or symbol libraries, are designated with their appropriate IFC tag by default. Below is 
a list of major building components and their corresponding IFC object tags. This can 
be used as a guide to determine the appropriate IFC tag for user-defined objects.

Base Cabinet = IfcFurnishingElement

Bath-Shower = IfcFlowTerminal

Ceiling Grid = IfcCovering

Clothes Rod = IfcFurnishingElement

Column = IfcColumn

Column Wrap (Architectural column) = IfcCovering

Comm Device = IfcDistributionFlowElement

Compartment Sink = IfcFlowTerminal 

Counter Top = IfcFurnishingElement

Curtain Wall (Straight & Curved) = IfcCurtainWall

Curtain Wall Frames = IfcMember

Curtain Wall Panels = IfcPlate 

Desk = IfcFurnishingElement

Door = IfcDoor

Drilled Footing = IfcFooting

Simple Elevator = IfcTransportElement

Escalator = IfcTransportElement

Fireplace = IfcDistributionFlowElement

Floor = IfcSlab

Framing Member = IfcMember or IfcBeam

Grab Bars = IfcRailing

Guardrail (Curved & Straight) = IfcRailing 

Handrail (Curved & Straight) = IfcRailing

HVAC Damper = IfcDistributionFlowElement 

HVAC Diffuser = IfcDistributionFlowElement

HVAC Elbow Duct = IfcDistributionFlowElement 

HVAC Flex Duct = IfcDistributionFlowElement

HVAC Outlet = IfcDistributionFlowElement 

HVAC Splitter = IfcDistributionFlowElement

HVAC Straight Duct = 

IfcDistributionFlowElement 

HVAC Transition = IfcDistributionFlowElement

HVAC Vertical Duct = 

IfcDistributionFlowElement 

HVAC Vertical Elbow = IfcDistributionFlowElement

Incandescent Fixture = 

IfcDistributionFlowElement 

Landscape Wall (including Arc and Bézier) = IfcWall

Massing Model (on layer mapped 

to site) = IfcBuilding 

Mullion = IfcMember

Parking Spaces = IfcSpace 

Pilaster = IfcColumn

Pillar = IfcColumn 
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USING IFC IN VECTORWORKS [CONT’D]

Piping Run = IfcDistributionFlowElement

Plant = IfcBuildingElementProxy 

Ramp = IfcRamp

Receptacle = IfcDistributionFlowElement 

Roadway (all types) = IfcTransportElement

Roof = IfcRoof (containing instances 
of IfcSlab) 

Roof Face = IfcSlab

Seating Layout = IfcFurnishingElement 

Round Wall = IfcWall or IfcWallStandardCase

Wall = IfcWall or IfcWallStandardCase 

Site Model = IfcSite

Shelving Unit = IfcFurnishingElement 

Slab = IfcSlab

Space = IfcSpace 

Stair = IfcStair

Switch = IfcDistributionFlowElement 

Table = IfcFurnishingElement

Tables and Chairs = IfcFurnishingElement 

Toilet Fixture = IfcFlowTerminal

Utility Cabinet = IfcFurnishing Element 

Wall Cabinet = IfcFurnishingElement

Window = IfcWindow

Workstation Counter = IfcFurnishingElement

Workstation Overhead = IfcFurnishingElement 

Workstation Panel = IfcFurnishingElement

Workstation Pedestal = IfcFurnishingElement 



FIGURE 1 
Door OIP Updated (left), Selected Door (right)
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USING IFC IN VECTORWORKS [CONT’D]

Additionally, as of Vectorworks version 2010, nearly all symbols in the Vectorworks 
Architect default symbol libraries have appropriate IFC2x3 object tags pre-attached, 
so that symbols used from these libraries properly export to IFC2x3.

When exporting objects, such as doors, geometric information (width, height, opening direction, 
etc.) is automatically exported, as it is based on the physical geometry of the object. This way 
model checking applications, like Solibri, can find collisions with other geometry, such as 
columns, low ceilings, or MEP elements like pipes or ducts. When these objects have a default 
IFC tag they are also assigned an appropriate default property set associated with the IFC 
object. For example, a default door object is tagged as an IfcDoor and has the IfcDoor property 
set associated with it (FIGURE 1). Other property sets can be assigned to the object as needed. 

This guide will cover the behavior of some default objects in order to help you understand the 
process of assigning and managing IFC data and the IFC export within Vectorworks. Not all objects 
will be covered in detail. The hope is that with a better understanding of the IFC export behavior, 
the user will be able to troubleshoot any problems that arise due to missing data and/or geometry. 



FIGURE 2 
Select IFC Object Dialog Box

FIGURE 3 
IFC Data Dialog Box
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USING IFC IN VECTORWORKS [CONT’D]

THE IFC DATA DIALOG BOX

As mentioned before, nearly all default objects in Vectorworks will already 
have IFC data attached to them. The IFC Data dialog box can be used 
to assign, view, and edit IFC data associated with an object. 

TO ACCESS THIS DIALOG BOX:

1. Select the object.

Multiple items can be selected.

2. Select the menu AEC → IFC Data.

If the selected object does not have IFC data assigned to it, the Select IFC Object dialog box 
will open (FIGURE 2). This will prompt you to choose the IFC designation for the object(s) 
selected. See the Assigning IFC Data to Objects section of this document.

If the selected objects already have an IFC designation, the IFC Data dialog box will appear (FIGURE 3). 



FIGURE 3A 
IFC Data Dialog Box-GUID

FIGURE 3B 
IFC Data Dialog Box-Psets
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USING IFC IN VECTORWORKS [CONT’D]

THIS DIALOG BOX WILL DISPLAY FOUR KEY ITEMS:

1. An object’s IFC tag, or designation, and GUID (Global Unique Identifier) (FIGURE 3A).

2. The data sets that are assigned to the object – referred to as property sets, or pSets (FIGURE 3B). 
A check mark under the Use column indicates that this data set is attached to the object.



FIGURE 3C 
IFC Data Dialog Box-Psets Style Instance

FIGURE 3D 
IFC Data Dialog Box-Data Source
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3. The properties or values for the selected Data Sets and whether the value is by instance or by style 
(FIGURE 3C). 

A by instance icon indicates that the property value comes from either the value set within 
the IFC Data dialog box or an equivalent Vectorworks object parameter (a default value). A 
by style icon indicates that the property value comes from a custom data mapping that is 
defined by the user. See the IFC Data Mapping Command section. 

4. The data source for the value of the parameter in the property set (i.e. what is 
the equivalent Vectorworks data parameter in an object) (FIGURE 3D).

For more detailed information regarding the available fields in the 
IFC Data dialog box, visit Vectorworks online Help. 
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USING IFC IN VECTORWORKS [CONT’D]

ASSIGNING IFC DATA TO OBJECTS

When a Vectorworks project is exported as an IFC file, Vectorworks’ default building objects and 
the majority of default library symbols that have pre-assigned IFC data are exported as IFC objects. 
However, custom-made objects, or user-defined objects, are not exported unless they receive IFC 
assignments prior to export. Assigning IFC data to an object does not alter it in any visible way 
within Vectorworks. The object can still be edited with standard Vectorworks tools and commands. 

IFC assignments can be performed with the IFC Data command 
or with the IFC Data Mapping Command. 

TO ASSIGN IFC DATA WITH THE IFC DATA COMMAND:

1. Select the object, group, or symbol instance (symbols that have been placed 
in the drawing) for assignment of IFC data. 

Multiple items can be selected.

2. Select the menu AEC → IFC Data.

Alternatively, you can access the IFC Data dialog box 
by selecting an object and clicking the Data pane at the 
top of the Object Info palette. Then click the Attach IFC 

button found near the bottom of the palette (FIGURE 4). 

The Select IFC Object dialog box opens, listing available IFC 
object types (FIGURE 2). You have the ability to first choose 
what version of IFC is to be applied. Select the IFC object type 
to assign to the building object. Most entities supported by 
Vectorworks for export can be found in the Simple List. 

If you are using the Filter List option, please keep in mind 
that Filter List is not a Search function and cannot find a 
corresponding IFC tag for objects. For example, you cannot 
type in toilet and have the IfcFlowTerminal tag returned. 
To find the correct IFC tags for typical building objects, 
see the IFC Object Tags for Standard Objects section. 

See the IFC Object Tags for Standard Objects section to find the 
correct IFC tags for typical buildings or to tag custom-made objects. 

FIGURE 4 
Attach IFC Data Through the Data 
Pane in OIP 



FIGURE 5 
Alert when Applying IFC Data to a Symbol Instance
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USING IFC IN VECTORWORKS [CONT’D]

3. Select the IFC object type and click OK. The IFC Data dialog box opens (FIGURE 3). Under Object 
Properties, select the property set to attach to the IFC object by adding a check mark under the 
Use column. You can select multiple property sets. To enter the desired values for the properties 

of the selected data set, use the second pane to select the property and the String value field.

If you are attaching a custom property set to a unique instance of an 
object, select the Manage Custom Property Sets button (see the When 

to Use Custom IFC Property Sets section for more information). 

4. Click OK to assign the IFC data to the object. The Data Pane of the Object Info palette will 
now display the selected object’s IFC Entity type and the associated property sets. 

When attaching data to a symbol, there is the option to either attach the data to a 
specific instance of the symbol or to the symbol definition. When applying IFC data 
to the symbol instance, you will see the following dialog: (FIGURE 5). If you select Yes, 
the IFC data will be attached to all current instances of the symbol. This means 
that any future placement of the symbol will include the data as well. Select No 
if the IFC data is to be applied only to the selected instance of the symbol.



FIGURE 6 
Alert after Attaching IFC Data to a Symbol Instance
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To attach IFC data to a symbol definition through the Resource Manager, select the symbol 
definition, right-click and select IFC Data from the menu. After attaching the data, you will 
see the following dialog: (FIGURE 6). This attaches the IFC data to future symbol placements 
and to any current instances that do not have IFC data already attached to them. This 
option is best for making a universal change to the symbols through one operation. 

It is important to understand that the IFC Data command will only attach data to the 
selected objects and will not alter any other instances of that object (except for symbols as 
stated above). It assigns IFC data to all instances of a particular object, use the IFC Data 
Mapping command as described in this document and in Vectorworks online Help. 

USING IFC IN VECTORWORKS [CONT’D]
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USING IFC IN VECTORWORKS [CONT’D]

VIEWING AND EDITING IFC DATA

The data attached to Vectorworks objects or IFC entities, whether created in 
Vectorworks or imported from an IFC file, can be viewed and edited with the IFC 
Data command or from the Data pane of the Object Info palette itself. 

TO ACCESS IFC DATA FOR EDITING THROUGH THE IFC DATA COMMAND:

1. Select the IFC Entity or Vectorworks object. 

Multiple items can be selected.

2. Select AEC → IFC Data. 

3. When the items to be edited have been specified, the IFC Data dialog box opens. View 
or edit the IFC data as described in the Assigning IFC Data to Objects section.

If an IFC Entity is selected, the IFC Data dialog box displays the data attached to 
the entity as described in the Assigning IFC Data to Objects section.

If a group contains multiple objects with differing IFC object types, the IFC tag 
assigned to the group will not be assigned to the individual objects. That is, 
the objects within the group will retain their respective IFC tags. 

If a symbol contains multiple objects with different IFC object types, a 
property set cannot be set to the symbol definition or symbol instance itself. 
Instead the objects within the symbol should be grouped and the appropriate 

property set can be attached to the group within the symbol.

The source of specific data values for a property set’s parameters can be determined 

by the Data Source field at the bottom of the IFC Data dialog box.



FIGURE 7 
IFC in OIP

FIGURE 8 
IFC in OIP Parameters
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USING IFC IN VECTORWORKS [CONT’D]

TO ACCESS IFC DATA FOR EDITING THROUGH THE OBJECT INFO PALETTE:

1. Select the IFC Entity or Vectorworks Object – multiple items can be selected. 

2. Click the Data pane in the Object Info palette. The assigned IFC entity type displays at the top 
of the palette (FIGURE 7). All default property sets for the IFC entity display below the entity type 
name. Property sets in use will have a check mark to the left of the property set name.

3. To add an additional property set, click in the left column to add a checkmark next to the property set.

Once the property set is added, the values for the parameters of the set displays below the buttons  
(FIGURE 8). Some fields can be filled out directly. If the parameter field is grayed out and cannot be accessed, 
this indicates that the parameter is populated by either a predefined, default mapping from an object 
parameter, or from a user-defined mapping (see the IFC Data Mapping Command section of this document).

Remember that any data that is added through the Object Info palette or 
through the IFC Data dialog is only applied to that instance of the object. 



FIGURE 9 
Space Settings-Occupancy

FIGURE 10 
IFC Zones Dialog Box
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USING IFC IN VECTORWORKS [CONT’D]

ASSIGNING IFC DATA TO SPACE ZONES

Most Vectorworks space information is automatically written to the corresponding data fields 
of the IFC property set. However, space zones, are a special case and are addressed here.

A zone is a collection or group of spaces with a shared characteristic, such as security  
restrictions and privacy. Space zones have many purposes, such as defining programmatic  
use or a fire compartment or area of refuge. 

In general, a space in Vectorworks does not need to be associated with a zone; however, 
for a zone to exist, spaces are necessary. The same is true for IFC Zones – IFC Space does 
not need to be a zone assignment, but IFC Zones cannot exist without an IFC Space. 

In Vectorworks, the IFC Zone data is attached to the space zone 
definitions themselves, not to the space objects. 

The IFC Zones, Systems, and Groups command attaches IFC data to the specified zones in the 
current file. This means that zones must already exist in the file. Zones are initially created 
when they are assigned to a space object. This can either be done from the Occupancy pane 
of the Space Settings dialog box (FIGURE 9) or from the Object Info palette (FIGURE 10). Zones are 
generally divided into four main categories: HVAC, Preservation, Privacy, and Security. Once 
a zone is assigned to a space, that zone is automatically tagged with the IfcZone designation 
and will export with the appropriate field from the space object’s zone assignment. This 
IFC data can be adjusted or amended with additional information and property sets. 



FIGURE 11 
IFC Zones, Systems and Groups
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USING IFC IN VECTORWORKS [CONT’D]

TO VIEW AND AMEND IFC DATA TO ZONES IN THE FILE:

1. Select AEC → IFC Zones, Systems, and Groups.

The IFC Zones, System, and Groups dialog box opens.

2. Zones in use in the file are listed above the divider line; available IFC zones are 
listed below the divider. Select a zone and click Edit (FIGURE 11). 

Only one zone can be selected at a time.

3. The IFC Data dialog box opens. The object type is automatically set to 
IfcZone, and the property Name value is set to the zone name. 

4. Edit or add any data sets through the IFC Data dialog box.

5. Click OK to attach the IFC data to the zone.



FIGURE 12 
IFC Data Mapping Dialog Box
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USING IFC IN VECTORWORKS [CONT’D]

THE IFC DATA MAPPING COMMAND

WHAT IS THE IFC DATA MAPPING COMMAND
The IFC Data Mapping command allows the user to define what parameters of an 
object, and its corresponding values, are transferred to an identified, parallel IFC 
data set. In essence, this command allows customized control of the transfer of data 
from Vectorworks objects to IFC objects. The command gives you the ability to:

 ∙ Map non-IFC objects with a defined set of IFC parameters
 ∙ Map a Vectorworks object parameter value to the equivalent IFC parameter 
 ∙ Attach property and data sets to objects in addition to the default IFC property set
 ∙ Identify which specific object parameters or record format parameters 

should map to an IFC parameter within the identified property set
 ∙ Define, save, and recall multiple, various custom mapping configurations as a saved setting

The IFC Data Mapping command allows the user to edit, or redefine, the default IFC tag 
or assignment for all default objects within Vectorworks (FIGURE 12). This command also 
allows you to set a default IFC assignment for all custom-made objects. From here, you 
can define what additional property and data sets within the IFC assignment are used by 
default (FIGURE 13). In the third pane of the dialog box, users can define the mapping for the 
specific IFC parameters (FIGURE 14). A full explanation of the IFC Data Mapping dialog box 
can be found in Vectorworks online Help. It is highly recommended to read through the 
online Help to understand the purpose of all parameters and settings in this command. 



FIGURE 14 
Third Pane - Define Mapping for Specific Parameters

FIGURE 13 
Middle Pane
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USING IFC IN VECTORWORKS [CONT’D]



FIGURE 15 
User-Defined Field 
in the Door Object
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USING IFC IN VECTORWORKS [CONT’D]

WHEN TO USE THE IFC DATA MAPPING COMMAND
There are mvultiple instances in which the IFC Data Mapping command should be used.

 ∙ When additional data needs to be added to an object’s default IFC assignment

A number of Vectorworks objects will contain user-defined data that is not included as 
part of the default IFC assignment. For example, a type designation or acoustic rating for a 
door will be user-defined data within the door object. A user-defined field will be used in 
the door object (FIGURE 15) to add this information. These parameters can be mapped to the 
corresponding IFC parameter values using the IFC Data Mapping command (FIGURE 12). 

 ∙ When data from a custom record format needs to be mapped to an IFC property set. 

In Vectorworks, custom data is attached to objects (default objects, plug-in objects, and custom-
modeled objects) using record formats. (For detailed information on creating custom record formats, go 
to Vectorworks online Help.) The parameters of a custom record format can be mapped to the correct, 
corresponding IFC property set. For example, a local code or specification system may be attached to an 
object through a custom record. The parameters for these records can be mapped to the identified, IFC 
Classification data set to ensure that the data is transferred during an IFC model exchange.



FIGURE 16 
OIP Name
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USING IFC IN VECTORWORKS [CONT’D]

 ∙ When custom-made objects or symbols need a default IFC assignment and property sets attached. 

This is directly related to the second use of the IFC Data Mapping command described above. IFC 
assignments and property sets can be defined for all custom made objects, ensuring that each 
time the custom object is placed in the file, it will receive that appropriate IFC tag assignment.

 ∙ When file exchange requirements include mandatory or default IFC values.

There are some scenarios when BIM data exchange has specific requirements that 
need to be fulfilled. Some of these requirements may specify that every data field needs 
to have a default value or that certain data fields should not be left empty. 

HOW TO USE THE IFC DATA MAPPING COMMAND
When identifying the mapping, users can choose from either objects or 
IFC entities. In order to map the data of custom objects, such as symbols, 
they must be added to the list of objects and IFC entities. 

TO ADD CUSTOM OBJECTS:

1. Click the Add New button (FIGURE 12). 

2. In the Add Object dialog box, add the new object’s name. 
If it is a symbol, use the name of the symbol definition. 
If it is a modeled object, such as an extrude, the object 
name that is added should match the name that is 
defined by the user in the Object Info palette (FIGURE 16). 

3. Click OK.



FIGURE 17 
Change Mapping
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USING IFC IN VECTORWORKS [CONT’D]

THE NEW OBJECT WILL BE ADDED TO THE LIST AND WILL AUTOMATICALLY 

BE SELECTED. TO ADD THE IDENTIFIED IFC ENTITY TYPE OR TAG: 

1. Click the Change Mapping button (FIGURE 17).

2. The Select IFC Object dialog box opens (FIGURE 2). 

If you are using the Filter List option, please keep in mind that Filter List is not a Search 
function and cannot find a corresponding IFC tag for objects. For example, you cannot 
type in toilet and have the IfcFlowTerminal tag returned. To find the correct IFC tags for 

typical building objects, see the prior IFC Object Tags for Standard Objects section. 



FIGURE 18 
IFC Tag Assigned
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USING IFC IN VECTORWORKS [CONT’D]

3. After assigning the appropriate IFC tag, click OK and the appropriate data set will display in the middle 
pane of the window under IFC Entities/Data Sets for this object (FIGURE 18). This will now be the 
default IFC tag for any symbol or object that has the name that has been added to the object list. 

To see the corresponding IFC parameters for the added IFC data set, click the 
disclosure arrow (solid arrow head) to the left of Use column for the associated 
property set name. This will expand the property set, revealing all parameters. 



FIGURE 19 
Add Mapping
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TO ATTACH ADDITIONAL PROPERTY SETS:

1. In the list in the left-most pane of the dialog box, select the object to 
which the additional property set will be attached.

2. Click the Add button. The Add Mapping dialog box opens (FIGURE 19). 

3. Choose a property or data set from the long list of default IFC property sets. For example, to add 
the Manufacturer property set, add the pSet_ManufacturerTypeInformation property set. 

4. Click OK.

5. The property set will be added below the default set in the middle pane of the dialog box.

Each property set will have a check mark next to it. This check mark indicates 
that the property set will be attached to the object by default. To deselect 

the property set simply click on the check mark, converting it to an x. 



FIGURE 20 
Select IFC Parameter

FIGURE 21 
Define Mapping
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TO MAP THE APPROPRIATE OBJECT VALUES OR RECORD VALUES TO THE IFC PARAMETERS:

1. Click the solid arrow head next to the property set name in order to expand all parameters.

2. Select the desired parameter to map. For example, select the Manufacturer parameter 
in the pSet_ManufacturerTypeInformation property set (FIGURE 20). 

3. To the far right there is an empty box under the name of the parameter, indicating 
that the selected IFC parameter will not be pre-populated with object information. 
This is simply because this mapping has not been defined yet. 

4. Click on the Define Mapping button.

5. The Define Mapping dialog box opens (FIGURE 21).

USING IFC IN VECTORWORKS [CONT’D]
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6. Here you can identify where the mapping value should be populated from. The 
options include the object’s default parameter value, such as a door or window 
(or other Vectorworks plug-in object), or an identified record format.

7. After selecting a source, select the parameter that corresponds with 
the IFC parameter and should be mapped as such. 

8. The Formula field will generate the data source string, or call, for the parameter that has been mapped. 
This should match the Data Source field in an object’s IFC Data dialog box as discussed with Figure 3D.

There is an option to add More Choices. This option will only be used if there is a need 
for a backup source from which to map information. For example, if the first identified 
source for data mapping is empty or blank, the IFC parameter will be populated by 
this second, defined source. The most common use for a second source or a constant 
value is to fulfill file exchange requirements for mandatory or default values within 

certain IFC parameters. Examples of this can be found in Vectorworks Help.

9. Click OK. The defined mapping will now appear in the right window of the IFC Data Mapping dialog box. 

10. Map the remaining, relevant parameters as outlined in steps 1-9. 

11. Click OK.

When the object or symbol that has been added to the IFC Data Mapping command list 
is placed in the file, it will take on the identified IFC tag and property sets as part of 
its default settings. This can be confirmed by placing a symbol in the file, selecting 
the symbol, and viewing the IFC data in the Data pane of the Object Info palette.

USING IFC IN VECTORWORKS [CONT’D]



FIGURE 22 
Object Filter
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IF AN OBJECT’S EXISTING MAPPING NEEDS TO BE AMENDED OR EDITED:

1. Open the IFC Data Mapping dialog box. 

2. Select the object that needs to be edited — use the Filter field found at the top of the object list (FIGURE 22).

3. Once the object is selected you can edit the default IFC tag by clicking the Change Mapping 
button or you can attach additional property sets by clicking the Add button.

4. Follow the steps listed above to map the appropriate values to the identified IFC property set parameters.

Once a mapping has been defined for specific objects, these definitions can be saved as mapping 
settings. These settings can be recalled in different files that may require the same custom 
mapping. For more information on managing IFC Data Mapping settings refer to Vectorworks 
online Help.

USING IFC IN VECTORWORKS [CONT’D]
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WHEN TO USE CUSTOM IFC PROPERTY SETS

Property sets (or pSets) are used to assign groups of data fields, or properties, characteristics, 
or classifications, to IFC objects. Essentially, property sets can be thought of as named sets of 
individual properties. For example, the property set pSet_ManufacturerTypeInformation will 
include property values such as the manufacturer name, the model name, the article number, etc. 

Property sets can be very specific to an IFC object, such as pSet_WallCommon to IfcWall, or they 
can be more general and applied to any IFC object, such as pSet_ManufacturerTypeInformation. 

Because IFC is extensible, any user-defined data set can be assigned 
to an IFC object, even if it is not in the predefined list of data sets in the 
IFC Data dialog box. These are called custom property sets. 

Custom property sets are only needed when specific data for unique objects have no parallel 
or comparable IFC property set or to consolidate data into one or two comprehensive data 
sets. This type of consolidation does allow for some ease in the export workflow. However, it is 
encouraged that the user find an appropriate pre-existing or default IFC property set and use the 
IFC Data Mapping command before deciding on creating and attaching a custom property set. 

Custom property sets are captured and exchanged in the IFC 
format through Vectorworks’ record formats. 

CREATING IFC-COMPATIBLE RECORD FORMATS 

To create a custom property set, a record format must first be created to define the data that 
will be captured in the IFC export. This record format can consist of as many fields as needed. 
The custom property set will inherit the name of the record format. There are no real defined 
standards or guidelines for naming conventions of custom property sets. You can name them 
for what is appropriate for your project. It is recommended that a consistent and logical naming 
method be agreed upon by all consultants on a project and is used and implemented by all parties 
creating and sharing their BIM model. Additional information regarding naming and field values 
of a record format for custom property sets can be obtained from Vectorworks online Help.



FIGURE 23 
Manage Custom PSets
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CONVERTING A RECORD FORMAT TO AN IFC CUSTOM PROPERTY SET

Once the record format has been created, it will be available as an IFC property set 
and can be attached to an object, group, symbol definition, or symbol instance.

TO ASSIGN THE CUSTOM IFC DATA SET:

1. Select the object, group, or symbol for assignment of IFC data.

2. Through the Data pane of the Object Info Palette, click on Attach IFC Data.

3. In the Select IFC Entity dialog box, select the IFC object type as 
described in the Assigning IFC Data to Objects section.

4. Click OK.

The IFC Data dialog box opens.

5. Click Manage Custom Property Sets.

The Manage Custom Property Sets dialog box opens (FIGURE 23).

6. Click in the Use column to include a record format. Selected record formats display with a 
check mark. You can select multiple record formats if they are present in the document. 

7. Click OK to return to the IFC Data dialog box (FIGURE 3).

The selected custom record formats are listed as data sets in the 
IFC Entities/pSets list under Object Properties.



FIGURE 24 
Proxy Elements
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8. Select the custom property set and click in the Use column. A check mark 
indicates that the property set is enabled and attached to the object.

9. Select the custom pSet properties and assign values to the selected 
properties through the String value for selected property field. 

It is important to remember that any values added to this custom record for an object via 
the data pane in the Object Info palette will not automatically carry through as IFC data. 
The custom record must first be attached as a custom property set and then the values 
can be added through the three ways that have been discussed: The Data pane of the 
Object Info palette, the IFC Data command, or the IFC Data Mapping command. 

10. Click OK to assign the IFC data to the object.

The IFC data can be reviewed or edited by clicking the Data pane in the Object Info palette of a 
selected IFC object or entity, or by selecting the object or entity and selecting AEC → IFC Data. 

 
Because the custom property set is based on a record format it can be saved and imported to a 
different project for repurposing. To use a custom property set in another file or project, export 
the record format to another file and repeat the Manage Custom Property Sets process.

PROXY ELEMENTS

The proxy element tag is reserved for model 
elements that do not have a semantic definition in 
the current IFC release. IfcBuildingElementProxy 
should be used to export special types of building 
elements that do not have a defined meaning for 
the element type. This means any object that does 
not fit any of the IFC semantic types found in the 
Select IFC Entity dialog box’s full list, should be 
tagged as a proxy element. This will include any 
site elements that are incorporated in the model 
that may not have an IFC type equivalent. 

Proxy elements have generic property sets associated 
with them that include basic information such as 
object name, description, and object type (SEE FIGURE 24). 
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SPECIAL CASES

Stairs and Plugin Objects in Symbols

When using the Stair tool to create stair objects, it is advisable to not mirror a stair object 
when creating additional stair elements. The best course is to duplicate the stair, enter the 
stair object’s dialog box, and change the handedness, rather than using the Mirror tool.

You may find that other geometry within symbols will display the same type of 
behavior. If so, place the symbol again without using the Mirror tool. 

COLUMN GRID

If your project calls for a non-orthogonal or complex column grid, a column grid can be exported 
from Vectorworks by using 2D linework as the grid instead of the default Grid Bubble tool found in 
the Dims/Notes palette. Use lines, arcs, or circles to draw your grid. Each line of the grid must be 
individually tagged with IFC data by selecting IfcGridAxis from the list in the IFC Entity dialog box. 

Lines drawn for the vertical grid need a tag prefix of V and lines 
drawn for the horizontal grid need a tag prefix of U.

For a third part of the grid that may include column lines at an angle, the prefix W will be used. This 
prefix is reserved for only when you have a 3-grid axis. The IFC grid can only support these 3 axes 
and nothing more. If necessary, you may need to create a primary grid and a  secondary grid.



FIGURE 25 
Axis Grid
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FOR EXAMPLE: 

1. For lines drawn vertically, select a line, Select AEC → IFC Data, and click on the IfcGridAxis selection. 

2. Under Object Properties select the IfcGridAxis property set to see the properties below. 

3. Choose AxisTag and enter the prefix V and the letter of the grid in the field 
for String Value for Selected Property (FIGURE 25). Click OK. 

4. Select the next grid line and repeat. Use the prefix U for horizontally drawn grid 
lines. Use the prefix W for any angled axes or other, tertiary types of axes. 

5. Once all the axes are labeled as IfcGridAxis, group all of the lines, arcs, or circles together.

6. Select the group, select AEC → IFC Data, and click on IfcGrid to attach the IfcGrid tag to the group.

You can set up a name for the grid in cases where multiple grid groups exist.

To create a secondary grid, follow the same steps, but create a separate group with the same, IfcGrid tag. 
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EXPORTING

Generally, Vectorworks files are exported as entire projects (sites with buildings consisting of 
stories) to be exchanged or analyzed with other IFC-compatible applications. When you use the 
Export IFC Project command, you assign design layers to building stories. For a project initially 
set up with Vectorworks’ story organization, this assignment, called layer mapping, is done 
automatically. This means that the layers assigned to the building stories are automatically 
included in the Mapped Layers list and are mapped to an appropriately named IFC Story. 
Mapping can also be controlled manually, letting you override or edit the automated process. 
The manual process is also used if you have chosen to not use Vectorworks’ story organization. 
Keep in mind that when the layers are mapped manually, the last mapping settings are 
retained by Vectorworks. You will only need to map layers again if any new layers are added.

The following guidelines may be useful when preparing your model for export:

 ∙ Set up the project with stories from the beginning. Though not completely 
necessary, it does automate part of the export process.

 ∙ Take care to set up the elevation values of layers correctly. Verify that all 
the objects in the drawing are vertically aligned as necessary. 

 ∙ If you are using standard Vectorworks plug-in objects, it is best to use those 
listed in the IFC Object Tags for Standard Objects portion of this guide. 

 ∙ Use the IFC Data command to attach IFC data to custom symbols 
and objects, so that they will be recognized at IFC export.

 ∙ Use the Choose Schedule command to generate IFC schedules for default 
objects, or create your own schedules to verify and correct the IFC data attached 
to objects. (Be aware that these schedules are not bi-directional.)

 ∙ Before exporting, set the 3D Conversion Resolution lower to optimize the file size — Tools 
→ Options → Vectorworks Preferences → 3D → 3D conversion resolution → Low 

 ∙ Select only the layers you want exported by using the Export Visible Objects 

Only option on the Export IFC Project dialog box’s Data tab. 

 ∙ Set the model to Top/Plan view before exporting.

 ∙ Zoom your view into a small, simple corner of your model before exporting.

 ∙ If you are exporting the model specifically for energy analysis, many energy analysis 
programs require a unique element called a 1st Level Space Boundary - File → 
Export → Export IFC Project → Add-on Views → 1st Level Space Boundaries
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 ∙ Test the quality of the IFC export file by verifying it in an IFC model 
browser. Almost all IFC browsers can view and validate the model. 
Some examples of IFC browsers available at this time include:

 ∙ Solibri Model Viewer (Macintosh or Windows)

 ∙ FZKViewer (Windows)

 ∙ DDS-CAD Viewer (Windows)

 ∙ Tekla BIMsight (Windows)

 ∙ Constructivity Model Viewer (Windows)

 ∙ RDF IFC Viewer (Windows, Macintosh and Linux versions planned)

 ∙ Field3D (iOS)

 ∙ IFC WebServer (web browser)

 ∙ xBIM Xplorer (Windows) 

 ∙ IfcPlusPlus (Windows)

For more information regarding IFC viewers and other IFC-compatible applications, visit 
the buildingSMART IFC-Compatible Implementations Database or IfcWiki.org websites.

Vectorworks project files can be exported to .ifc, .ifczip, and .ifcxml formats.

Export to IFC Versions 2x2, 2x3, and 4 is supported, but version 2x3 is most commonly used 
in current practice. The export of a project to an IFC file is based on specifying the geometry 
and associated data needed for the use of the exported file. This specification is called a Model 

View Definition (MVD). Vectorworks software supports the use of MVDs to automate the export, 
or allows the user to manually define a custom set of geometry and data to be exported.



FIGURE 26 
Export IFC
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TO EXPORT A VECTORWORKS FILE TO IFC

1. Select File → Export → Export IFC Project.

The Export IFC Project dialog box opens (FIGURE 26). Under the Data tab, you’ll see a number of options 
for specifying the export options as well as the overall project information, such as project data, author 
data, site data, and building data. Any required field within this tab will be automatically filled based on the 
existing Vectorworks project information. 

For Export Options, select IFC version 2x3 (the default) and the CV 2.0 – Architecture Model View (also 
a default). This particular Model View is an official buildingSMART international view for exporting 
architectural models for coordination with structural and MEP models. 

If you have created any custom property sets, make sure that the Export Custom Property Sets box is 
checked (this should also be checked by default).

To better understand all the parameters within the Data tab of the dialog box, please visit Vectorworks 
online Help.



FIGURE 27 
Layer Mapping
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2. Click the Layer Mapping tab to specify which layers to export and the Vectorworks and IFC Story Name to 
assign to them at export (FIGURE 27). If a site model is set to a site layer and has been tagged for IFC, it will 
also be included. 

For a project initially set up with stories, mapping is done automatically so that the layers assigned to the 
building stories are automatically included in the Mapped Layers list and are mapped to an appropriately 
named story. Mapping can also be controlled manually.

Specify the associated building or site data for each of the mapped layers. 

To better understand all the parameters within this tab of the dialog box, please visit Vectorworks online 
Help.

3. Click OK to export the project.

Indicate the file name and location in the Save As dialog box. 

Be sure to append the file name with the .ifc file extension.

HOW TO SHARE AND USE YOUR IFC MODEL [CONT’D]
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IMPORTING 

An IFC project, including one containing multiple buildings or large information sets, can be 
imported into a Vectorworks file. The units of the imported file are determined by the Vectorworks 
file settings. An important thing to understand is that the file’s original presentation layers or 
CAD layers from an imported IFC file are assigned to corresponding Vectorworks classes. Also, 
the Import IFC command automatically assigns IFC building stories to their own design layers.

TO IMPORT AN IFC FILE:

1. Select File → Import → Import IFC.

2. Select the .ifc, .ifczip, or .ifcxml file to open, and click Open. The IFC 
import can be filtered based on elements or stories.

Alternatively, click the file to import and drag it into a window where a Vectorworks document is open

3. All IFC Stories and elements are imported by default. However, a filter can be 
applied allowing you to choose specific Stories or particular elements. 

 ∙ If Stories is selected, a list of all stories in the IFC file will be displayed. Stories with the designated 
check mark to the left are marked to be imported. If a Story needs to be removed, click on the 
check mark to remove it and exclude the story and all its elements from being imported. 

 ∙ If Elements is selected, a list of all IFC elements in the IFC file will be displayed along with the number 
of elements. To include or exclude particular elements will be the same process as with Stories.

4. Click OK.

5. The file will be imported.

For more detail on the IFC file import options visit Vectorworks online Help. 
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REFERENCE MODEL WORKFLOW

When considering the Reference Model workflow, think of the process as a one-way data exchange. 
This means that your model, when exported via IFC, is received by your consultants to be used 
as base information. This IFC file should not be used with the expectation that, upon receipt, the 
model can be edited and manipulated as objects created natively within your software. Instead, 
the IFC model will be used in a file-sharing environment called the Reference Model workflow.

In a Reference Model workflow, IFC models generated by the various consultants are 
collected by the project BIM manager who creates a federated model within an IFC 
browser application, such as Solibri Model Checker, for the purposes of clash detection, 
model validation, quantity takeoffs, and other necessary tasks. Once a model is validated 
within the IFC browser, it is shared among the consultants with relevant comments 
regarding the model. The consultants will then reference the validated IFC model into 
their own application to make the necessary additions and edits to their model.

This workflow helps facilitate an iterative process involving discussion and exchange between 
all project participants. It also addresses questions about model ownership and responsibility 
by eliminating the possibility of editing parts of the model that you are not responsible for.
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OTHER RESOURCES AND INFORMATION

There are multiple places online to access more detailed information 
regarding IFC and buildingSMART, the entity that oversees IFC.

You can visit the IFC Wiki page here. 

You can also access a full list of the different software that are IFC certified by buildingSMART here. 

Information regarding Model View Definitions and the standardization of 
Exchange Requirements by buildingSMART can be found here.

Helpful resources to understand the IFC Entity data schemes and their 
corresponding property sets are also available online.

For IFC 2x3, they can be found here.

For IFC4 Reference View, they can be found here.

http://www.ifcwiki.org/index.php/Main_Page
http://www.buildingsmart-tech.org/certification/ifc-certification-2.0/ifc2x3-cv-v2.0-certification/participants
http://www.buildingsmart.org/standards/mvd/model-view-definitions-mvd
http://www.buildingsmart-tech.org/ifc/IFC2x3/TC1/html/psd/
http://www.buildingsmart-tech.org/mvd/IFC4Add1/RV/1.0/html/
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TERMINOLOGY

IFC - Industry Foundation Classes is a platform neutral, open file format that is not  
controlled by a single software vendor or a group of vendors. It is an object-based  
file format with a data model developed by buildingSMART to facilitate interoperability  
in the AEC industry. It is a commonly used collaboration format in BIM based projects.

OPEN SOURCE FILE FORMAT - a format whose technology is freely available to the  
public for development.

STANDARDIZED FILE FORMAT - a format that follows a standard way that information is  
encoded for storage in a computer file. It specifies how bits are used to encode information 
in a digital storage medium. 

SEMANTIC OBJECT - a representation of a collection of attributes that describe an identifiable 
object. This means that the model describes the meaning of instance. The support of semantic 
objects is what makes IFC ideal for an open BIM exchange. 

EXTENSIBILITY - a design or coding principle that takes future growth into consideration. 
Extensions can be through the addition of new information or through modification of existing 
functionality. IFC is an extensible file format in that new information can be added to existing 
information or existing information can be modified. 

DYNAMICALLY EXTENSIBLE - the principle of being able to dynamically change or load in new 
information without changing the existing information. Adding new IFC information to an existing 
Record Format is a good example of this. 

IFC OBJECT TAG - a label or tag that helps identify an IFC object. 

IFC OBJECT TYPE - an object that has been identified as building element with the  
corresponding IFC tag.
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PROPERTY SET - attributes that define a particular type of object. IFCPropertySet  
are a collection of predefined attributes that are used to define an object.  
Property sets are also referred to as pSets.

CUSTOM PROPERTY SET - user created/defined property sets. 

MODEL VIEW DEFINITION (MVD) - also called an IFC View Definition, a Model View Definition 
defines the IFC information needed to satisfy any of the Exchange Requirements  
defined by buildingSMART for collaboration.
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